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FESTO 自动化技术教学培训系统可应用于不同程度的培训中，满足不同的

要求。模块化的系统和工作站(MPS)源自实际工业应用，所有试验元件都

是根据工业元件而设计。 

 

供料单元可以为使用者提供下列能力的培训 

 合作能力 

 技术能力 

 逻辑能力 

 

此外，培训还可以培养团队精神和组织能力。 

 

通过培训内容可以了解实际项目的工作步骤，比如： 

 设计 

 安装 

 编程 

 调试 

 操作 

 维护 

 错误诊断 

 
 
 
 
 
 
 
 
 
 
 
 

1．简介 
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培训内容包括下面几部分： 

 机械 

- 工作站的机械构造 

 气动 

- 气动元件的连接 

- 真空技术 

- 无杆缸和旋转气缸 

 电气 

- 电气元件的连接 

- 无杆缸和旋转气缸 

 传感器 

- 正确使用行程开关 

 PLC 

- PLC的编程和使用 

- PLC程序结构 

 调试 

- 生产系统的调试  

 错误诊断 

- 生产系统的错误诊断 

实际工程项目 

 用 PLC替代继电器控制 

 选择气动元件 

- 无杆缸 

- 摆动缸 

- 真空吸盘 

 气泵故障时的安全处理 

- 真空储能器 

 PLC编程 

- 工作部分的编程 

- 复位顺序的编程 

      - 急停功能的编程 

1.1 培训内容 
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 控制循环时间 

请注意阅读关于 MPS的基本安全要求，包括安全建议和规则。 

本手册包括 MPS的安全规则。 

任何操作 MPS的相关人员都要阅读安全规则。 

此外，对于防止发生事故的规则和要求也要认真阅读。 

 

只有下列人员可以操作 MPS： 

 熟悉基本的安全和防止意外事故规则，并接受过 MPS培训的人员 

 已经阅读并了解安全规则和注意事项的人员 

 操作人员要具备良好的安全意识 

 

在开始工作之前，所有的操作人员都要注意： 

 阅读本手册的安全规则和注意事项 

 注意基本的安全和防止意外事故的规则 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

1.2 重要事项 

1.3 操作规则 

1.4 培训要求 
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MPS根据工业实际技术而设计，并且有专门的安全规则。但是在使用该系

统时，由于机械或其它问题，可能还会存在一些危险。 

 

在以下前提中使用 MPS： 

 了解工作站功能 

 工作环境绝对安全 

 
 
 
 

如果工作环境不安全，必须马上调整！ 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

1.5 MPS 的操作风险 
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作为自动化技术培训系统的主要供应商，我们的产品质量值得您信赖。对

于人员受伤和设备损坏的投诉，如果是以下原因，我们不进行担保： 

 没有按照规则使用 MPS 

 错误安装，调试，操作和维护 MPS 

 使用不安全的工具操作 MPS，或是不正确的安装，没有符合操作安全

条件，或没有保护装置 

 没有遵从手册中关于 MPS的运输，保存，安装，调试的规则 

 对 MPS进行不允许的修改 

 错误的维修 

 其它非人为因素 

 

因此，除出现 Festo Didactic 元器件的重大损坏以外，Festo Didactic将不对由

于在教学环境以外的其它情况导致的对学员、培训机构及第三方的伤害负

责。 

 

本系统适合于自动化技术领域的培训和使用。培训人员和/或指导教师要保

证培训生阅读过手册中的安全规则和注意事项。 

系统的使用包括：  

 手册中的所有装置 

 进行检测和维护工作 

 
 
 
 
 
 
 
 
 
 
 
 

1.6 责任和担保 

1.7 系统的使用 
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通常 

 培训生必须在指导教师的监督下操作工作站 

 阅读数据表中每个元件的特性数据，尤其是安全规则 

 

电气 

 只有关闭电源后，才可以拆除电气连接线 

 允许的最大电压为 24DC 

 

气动 

 不要超过最大允许压力 8bar(800Kpa) 

 将所有元件连接完并检查无误后再打开气源 

 不要在有压力的情况下拆卸连接 

 当打开气泵时要特别小心。气缸可能会在接通气源的一瞬间伸出或缩

回 

 

机械 

 在实验板上安装所有元件 

 元件工作时不要用手触动 

 
 
 
 
 
 
 
 
 
 

2. 安全说明 
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3. 技术数据 

3.1  组合 
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运输 

MPS运输时要放在有底盘的包装箱内。 

包装箱在装卸时，要用叉车进行升降，千万注意不能从高处落下。 

如果在运输过程中有任何损坏，请马上通知 FESTO Didactic和运输人员。 

 

包装 

在拆装时，要小心地拆下包装箱的外层包装材料，确保工作站不被损坏。 

一旦在拆装时发现工作站有任何损坏，请马上通知 FESTO Didactic和运输

人员。 

 

注意事项 

检查运货号和说明，如发现任何差错，请马上通知 FESTO Didactic。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 运输/包装/注意事项 



 

13  

 

 
 
 
 
 

 
 

供料单元是一个供货装置。根据 VDI 3240，供料单元的包括料仓、分类和

元件的供给。此外，根据不同的元件材料(形状，重量等)，供料单元可以

很快捷地对工件进行分类。 
 
供料单元包括下列部分： 

 料仓 

 进料器 

 传送带 

 分类装置 

工件包括： 

 电镀工件 

 塑料工件 

 冲压形成的工件 

 旋转元件 

 

5.1 供料单元 5. 设计和功能 
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供料单元的功能 

 堆栈料仓 

 摆动模块 

 实验板 

 

 底车 

 控制面板 

 PLC板 

 

 
带有底车，控制面板和 PLC板的供料单元。 
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供料单元将工件从料仓中推出。料仓最多可以装下 8 个工件。料仓内是否

装有工件由光电式传感器进行监测。双作用气缸将工件逐个推出。 
 
摆动模块上装有一个吸盘，可以将推出的工件吸起。一个真空检测开关可

以检测到工件是否被吸起。摆动模块的摆臂由摆动缸驱动，将工件传送到

下一个工位上。 
 
 
启动条件 

 料仓中装有工件 

初始位置 
 送料缸伸出 

 摆动缸处于“料仓”位置 

 真空关闭 

顺序 

1． 如果料仓中有工件，按下 START 按钮后，摆动缸转换到“下一工位”

位置。 
2． 送料缸缩回，工件从料仓中推出。 
3． 摆动缸转换到“料仓”位置。 
4． 真空启动。当工件被吸起，真空开关切换。 
5． 送料缸伸出，工件落下。 
6． 摆动缸转换到“下一工位”位置。 
7． 真空关闭。 
8． 摆动缸转换到“料仓”位置。 
 
 
 
 
 
 
 
 
 
 
 
 
 

5.2 功能 

5.3 顺序描述 
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料仓模块将工件从料仓中分离，直到堆栈排列的 8个工件全部被推出为

止。工件必须从顶端的开口处放入。 

一个双作用气缸将最底层的工件从料仓中推到机械限位位置。该位置是下

一模块的工作位置(比如，摆动模块)。 

料仓中是否有工件由一个光电式传感器监测。送料缸的位置通过电感式传

感器监测。送料缸的前进和缩回速度通过单向节流阀调节。 

 
 
 
 

5.4 料仓模块 
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摆动模块是一个气动提取装置。工件被吸盘吸起并通过摆动缸传送。摆动

范围可以通过机械调整控制在 0到 180度之间。极限位置可以通过行程开

关进行监测(微型开关)。 

摆动模块可以使用两个不同的吸盘。如下所述： 

 工件符号：吸盘 VAS-30-… 

 安装在气缸上：吸盘 VAS-8-… 

 

摆动缸的极限位置根据下一工位的位置 可以调节。 

 
 
 
 
 

5.5 摆动模块 
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MPS工作站通常要完成： 

 元件安装 

 每个站单独工作 

 调试 

 测试 

 

注意 

如果工作站组合在一起，可能要进行机械，位置和传感器的改变。 

 

调试工作通常只限于视觉上的检查，保证气管连接/导线和电压的正确。 

所有的元件，气管和导线都有编号，可以很方便地进行安装和连接。 

 

调试 MPS工作站时有下列要求： 

 安装并调节 MPS工作站 

 一个控制面板 

 一个 PLC板 

 一个 24VDC，4.5A电源 

 6bar(600 Kpa)的气源。吸气容量 50l/min 

 装有 PLC编程软件的 PC机 

 
 
 
 
 
 
 
 
 
 
 
 

6. 调试 

6.1 工作站 
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1． 实验板 

2． 沟槽螺母 M6x-32(4x) 

3． 底车 

4． 螺钉 M6x10(4x) 

5． 螺钉 3.5x9(2x) 

6． 控制面板 

 

6.2  机械组装 
 

6.2.1  安装实验板 和控制面板 
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关于供料单元的组装说明请参考光盘 English\1_Distributing\Assembly 
instructions。 

 

 
 
 
 
 
 
 
 
 
 

6.2.2 组装工作站 
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6.3.1 接近式传感器(堆栈料仓，送料缸) 

接近式传感器安装在气缸的末端位置。接近式传感器对安装在气缸上的永

久磁铁进行感应。 

 

准备条件  

- 安装料仓和接近式传感器 

- 连接气缸 

- 打开气源 

- 连接传感器导线 

- 打开电源 

 

执行步骤 

1． 将气缸与电磁阀连接，用电磁阀控制气缸运动。 

2． 将传感器在气缸轴向位置上移动，直到传感器被触发，触发后状态指

示灯(LED)亮。 

3． 在同一方向上轻微移动传感器，直到状态指示灯(LED)熄灭。 

4． 将传感器安装在触发和关闭的中间位置上。 

5． 用内六方扳手 A/F1.3将传感器固定。 

6． 启动气缸，检查传感器位置是否正确(气缸活塞杆前进/后退)。 

 

文档 

 数据表 

接近式传感器 SME-8(150857)的数据在光盘 English\1_Distributing\Data 
sheets。 

 操作指南 

接近式传感器 SME-8(646518)的操作指南在光盘

English\1_Distributing\Operating instructions。 

 安装指南 

料仓模块的安装指南在光盘 English\1_Distributing\Assembly instructions。 

 
 

6.3 调节传感器 
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6.3.2 光电式传感器(料仓，填充高度) 

光电式传感器用于监测料仓是否有工件。从光栅上导出一根光纤导线。传

光栅发出红色可见光。如果料仓有工件，会遮挡住红色光。 

 

准备条件 

- 安装传感器 

- 连接传感器 

- 接通电源 

 

执行步骤 

1． 将光纤导线探头安装在料仓上。 

2． 将光线导线连接至光栅上。 

3． 用六方扳手调解传感器的灵敏度，直到指示灯亮。 

注意 
调节螺孔最大只能旋转 12圈。 
 
4． 将工件放入料仓中。传感器指示灯熄灭。 
 
文档 

 数据表 

光栅(150857)和光纤导线(165360)的数据在光盘 English\1_Distributing\Data 
sheets。 

 操作指南 

光栅(369669)和光纤导线(369684)的操作指南在光盘

English\1_Distributing\Operating instructions。 

 安装指南 

料仓模块的安装指南在光盘 English\1_Distributing\Assembly instructions。 
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6.3.3 行程开关(摆动气缸) 

行程开关用于摆动缸末端位置的传感。安装在气缸上的可调节的凸轮触发

行程开关。 

 

准备条件 

- 安装摆动模块和行程开关 

- 连接摆动气缸 

- 打开气源 

- 连接行程开关 

- 接通电源 

 

执行步骤 

1．将气缸与电磁阀连接，用电磁阀控制气缸运动。 

2．在摆动缸的滑槽上移动行程开关凸轮，直到行程开关被触发。 

3．固定螺钉。 

5． 启动摆动缸，检查行程开关是否安装在正确位置上(向左/向右移动摆动

缸) 

 

文档 

 数据表 

行程开关 S-3-E(007347)和摆动缸 DSR-16-180(011910)的数据在光盘

English\1_Distributing\Data sheets。 

 操作指南 

摆动缸(235679)的操作指南在光盘 English\1_Distributing\Operating 
instructions。 

 安装指南 

摆动模块的安装指南在光盘 English\1_Distributing\Assembly instructions。 
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6.3.4 真空检测开关(摆动，真空吸盘) 

真空检测开关用于监测吸盘上是否有工件。如果工件被吸起，真空检测开

关就会发出一个输出信号。 

 

准备条件 

- 安装摆动模块 

- 连接真空发生器，真空吸盘和真空检测开关 

- 打开气源 

- 连接真空检测开关的电气部分 

- 接通电源 

 

执行步骤 

1． 打开气源。 

2． 将工件放在吸盘处，直到被吸起。 

3． 逆时针方向旋转真空检测开关的螺孔，直到黄色 LED亮。 

4． 启动真空发生器，检查工件是否被吸起。移动摆动缸从一个末端位置

到另一个末端位置上。工件不能落下。 

 

文档 

 数据表 

真空检测开关 VPEV(152619)的数据在光盘 English\1_Distributing\Data 
sheets。 

 操作指南 

真空检测开关(382214)的操作指南在光盘 English\1_Distributing\Operating 
instructions。 

 安装指南 

摆动模块的安装指南在光盘 English\1_Distributing\Assembly instructions。 
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6.4 调节单向节流阀 

单向节流阀用于控制双作用气缸的气体流量。在相反方向上，气体通过单

向阀流动。 

 

准备条件 

- 连接气缸 

- 打开气源 

 

执行步骤 

1． 将单向节流阀完全拧紧，然后松开一圈。 

2． 启动系统。 

3． 慢慢打开单向节流阀，直到达到所需的活塞杆速度。 

 

文档 

 数据表 

单向节流阀(175056)的数据在光盘 English\1_Distributing\Data sheets。 

 操作指南 

气缸(391172)的操作指南在光盘 English\1_Distributing\Operating instructions。 

 
6.5 外观检查 

在进行调试前，必须进行外观检查！ 

在开始启动系统前，您必须检查： 

 电气连接 

 气源 

 机械元件(损坏，连接) 

 

在启动系统前，要保证工作站没有任何损坏！ 
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6.6 导线连接 

 
从 PLC上将导线连接至工作站的控制面板上。 

1．PLC 板—工作站 

PLC板的 XMA2导线插入工作站 I/O端子的 XMA2插座中。 

2．PLC 板—控制面板 

 PLC板的 XMA1导线插入控制面板的 XMG1插座中。 

3．PLC 板—电源 

 4mm的安全插头插入电源的插座中。 

4．PC—PLC  

 将您的 PC机通过编程电缆与 PLC连接。 
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6.7 气动连接 

 阅读技术数据！ 

 将气泵与过滤调压组件连接 

 在过滤调压组件上设定压力为 6bar(600 KPa) 

 

6.7.1 手动调节 

手动调节用于检查阀和阀-驱动组合单元的功能。 

 

准备条件 

- 打开气源 

- 接通电源 

 

执行步骤 

1．打开气源 

2．用细铅笔或一个改锥(最大宽度:2.5mm)按下手控开关。 

3．松开开关(开关为弹簧复位)，阀回到初始位置。 

4． 对各个阀逐一进行手控调节。 

5． 在系统调试前，保证阀岛上的所有阀都处于初始位置。 

 

文档 

 内容描述 

CPV_valve_pneumatic(165100)的内容在光盘 English\1_Distributing。 

 

6.8 电源 

 工作站所需电压为 24V DC(最大. 5A)。 

 PLC板的电压与工作站一致。 
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6.9.1 Siemens 控制器 

 控制器：Siemens S7-313C，S7-313c-2DP，S7-314或 S7-315-2DP 

 编程软件：Siemens STEP7 Version 5.1或更高版本 

 

1．使用 RS232编程电缆将 PC与 PLC连接 

2．接通电源 

3．打开气源 

4．松开急停按钮 

5．将所有 PLC内存程序复位： 

        - 等待，直到 PLC完成自检 

       CPU 31xC 
       - 将选择开关调到 MRES，保持该位置不动，直到 STOP指示灯闪烁两

次并停止闪烁(大约 3秒)。您可以松开开关。 

       - 再次将开关调到 MRES。STOP指示灯快速闪烁，CPU进行程序复位。

您可以松开开关。 

       - 当 STOP指示灯不再闪烁，CPU完成程序复位。 

       - MMC卡中的数据没有被删除。如果想删除卡中的内容，打开菜单

“PLC/Display Accessible Nodes”可以删除文件夹中的所有文件。 

      CPU31x 
      - 将选择开关调到 MRES，保持该位置不动，直到 STOP LED闪烁后不

变。 

      - 松开开关使其位于 STOP位置。这时必须马上将开关调回 MRES。
STOP LED开始快速闪烁。 

      - 您可以松开选择开关。 

      - 当 STOP LED不再闪烁时，完成复位。 

      - 准备下载 PLC程序。 

6． 模式选择开关位置 STOP位置。 

7． 打开 PLC编程软件。 

 
 
 

6.9 下载 PLC 程序 
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8． 解压缩文件 MpsC_R2.0.zip，该文件位于光盘 Sources\PLC 
Programs\Release C\S7。 

注意 

不要用 WinZip或其它软件对 ZIP文件进行解压缩。请使用 Siemens STEP7进
行解压缩。 

 
File→Retrieve…→选择文件(光盘：Sources\PLC Programs\Release 
C\S7)MpsC_R2.0.zip Open→选择 OK→解压缩：被解压缩的文件存在项目目

录中.OK→解压缩：下列对象已经被解压缩。您是否项打开这些文件？YES 

 

9．选择硬件配置并将它们下载到控制器中： 

- PLC 313C 
- PLC 313C 2DP 
- PLC 314 
- PLC 315 2DP 
 

10．选择项目 1VE_AS或 1VE_KFA 

         (AS=流程图，KFA=梯形图/功能块图/指令表) 
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11．将项目下载到控制器 

 
PLC→Download→遵循屏幕指示 

 

12．将 CPU上的模式选择开关调到 RUN位置。 
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6.9.2 FESTO/Beck 控制器 

 控制器：FESTO/Beck FEC FC640，IPC CPU HC02，IPC CPU HC20 

 编程软件： Festo FST Version 4.02 

 

1． 使用 TTL-RS232编程电缆连接 PC和 PLC 

2． 接通电源 

3． 打开气源 

4． 松开急停按钮 

5． 等待，直到 PLC完成自检 

6． 打开 PLC编程软件 

7． 保存光盘路径 Sources\PLC Program\Release C\FST 中的 1VE_FEC.zip文件 

 
Project→Restore…→打开 1VE_FEC.zip Open→另存为 1VE_FEC OK 
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8． 编译项目 

 
Project→Build Project 

9．将程序下载到控制器 

 
Online→Download Project→遵循屏幕指示 
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6.9.3 Allen Bradley 控制器 

 控制器：Micrologix(ML) 1500 

 编程软件：RSLogix 500/RSLINXLite 

 

1． 用 RS232编程电缆连接 PC和 PLC 

2． 接通电源 

3． 打开气源 

4． 松开急停按钮 

注意 

 以下的操作步骤可能要用到必要的 RSLINXLite/RSLogix 500在线参数！ 

 在关闭并退出 RSLogix 500和 RSLINXLite时，避免接口冲突！ 

 

CPU ML 1500—在线参数配置 

      - 等待，直到 PLC完成自检 

      - 打开 RSLINXLite软件 

Communications→Configure Drivers...→从列表“Available Driver Types“中选择

“RS-232 DF1“并点击 Add New...→确定后 OK→Auto configure→OK→Close 



 

34  

 

- 打开 PLC编程软件 

 
Comms→System Comms…→选择所需控制器并点击 OK 

 

5． 将 PLC全部内容复位 

- 等待，直到 PLC完成自检 

CPU ML 1500  
       - 将模式选择开关调到 REM或 PROG。 

       - 打开 PLC编程软件 

       - 选择 Comms→System Comms…→选择所需控制器并点击 Online 

       - 连接 PC和 PLC之后选择 Comms→Clear Processor Memory 并点击 OK 
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6．从光盘 Sources\PLC Programs\Release C\ML 1500中打开文件 01 VE_K 

 
File→Open…→选择文件 01 VE_K→Open 

7．将项目下载到控制器 

 
Comms.→System Comms.→选择控制器，点击 Download→确定下列事项 
(“Revision note”, “…sure to proceed with Download?”, “…want to go to online?”)点击

YES 或 OK 
8．将 CPU的模式选择开关调到 RUN位置 
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6.9.4 Mitsubishi/MELSEC 控制器 

 控制器：Mitsubishi FX1N 

 编程软件：GX IEC Developer 6.01 或更高版本 

 

1． 用 RS232/RS422编程电缆连接 PC和 PLC 

2． 接通电源 

3． 打开气源 

4． 松开急停开关 

5． 将 PLC全部内容复位 

- 等待，直到 PLC完成自检 

       CPU FX1N 
       - 将模式选择开关调到 STOP位置  

       - 打开 PLC编程软件 

       - 选择 Online→PLC Clear→All 并点击 YES 

       - PLC内容全部复位 

       - 准备给 PLC下载程序 

6．保存光盘 Sources\PLC Programs\Release C\FX1N中的文件 01 VE_AS.pcd 或
01 VE_FUP.pcd 

 
Extras→Project Restore…→选择文件 01 VE_AS.pcd 或 01 VE_FUP.pcd→Open
→选择 OK→确定后 OK 
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7．编译项目 

 
Project→Rebuild all 

8．将项目下载到控制器 

 
project→Transfer→Download to PLC…→确定后点击 OK 

9． 将 CPU的模式选择开关调到 RUN位置 
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1． 将 8个工件放入料仓中。工件要开口向上放置。 

2． 检查电源电压和气源。 

3． 手动复位前，将各模块运动路径上的工件拿走。 

4． 进行复位。复位之前，RESET指示灯亮，这时可以按下按钮。 

5． 如果在送料缸的工作路径上有多余工件，要把它拿走。 

6． 启动供料单元。按下 START按钮即可启动该系统。 

 

注意 

 任何时候按下急停按钮或 STOP按钮，可以中断系统工作。 

 选择开关 AUTO/MAN用钥匙控制，您可以选择连续循环(AUTO)或单步循

环(MAN)。 

 在多个工作站组合时，要对每个工作站进行复位。 

 警告指示灯 MAG。如果料仓内没有工件，EMPTY指示灯亮。放入工件

后，按下 START按钮即可。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.10 工作流程 
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6.11.1 网络 

在 MPS工作站中，用光电式传感器相互连接，进行通信。这种连接形式称

为 StationLink，它使用光电式传感器传送和接收信号。StationLink发射器安

装在进料端，接收器安装在出料端。通过打开或关闭 StationLink发射器，

可以发出工作站是否准备完毕或没有准备完毕的信号。 

工作站相互连接的传感器必须面对面的安装。用内六方扳手将传感器固定

在工作站上。 

注意 

在供料单元中，只有 StationLink接收器，在分装单元中只有 StationLink发射

器。 

 

6.11.2 硬件修改 

摆动缸的旋转角度 

根据下一工作站的位置不同，可以调节摆动缸的旋转角度。具体操作方法

请参考摆动缸的操作指南(235679)。 

文档 

 数据表 

摆动缸 DSR-16-180 (011910)的数据在光盘 English\1_Distributing\Data 
sheets。 

 操作指南 

摆动缸(235679)的操作指南在光盘 English\1_Distributing\Operating 
instructions。 

 安装指南 

摆动模块的安装指南在光盘 English\1_Distributing\Assembly instructions。 

 
 
 
 
 
 
 
 
 

6.11 工作站组合 
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供料单元的维护非常简单。可以使用软布或刷子对以下部分进行清洁： 

 光电式传感器的镜头，光纤和反射器 

 接近式传感器的工作面 

 整个工作站  

 

不要使用过硬或表面粗糙的工具进行清理。 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

7．维护 
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带有 AS-I 的供料单元 

 

带有 AS-I的供料单元示意图 

关于带有 I/O 接口的供料单元 

 料仓模块 

- 带有 AS-I的阀 

- 带有 AS-I的漫射式传感器 

 摆动模块 

- 带有 AS-I的 CP阀岛   

 标准 PLC板 

- Siemens CP 343-2 AS-I主站 

      - AS-I滤波器 

 

必要附件 

 AS-I寻址装置(参考：FESTO Didactic样本) 

 
 

附录 
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1.   带有 AS-I的阀 

2.   带有 AS-I的漫射式传感器 

3. 带有 AS-I的 CP阀岛 

带有 AS-I的供料单元具体内容 

 数据表 

导线(018685)，带 AS-I的阀连接器(196083)和带 AS-I的漫射式传感器

(532929)的数据在光盘 English\1_Distributing\Data sheets。 

 操作指南 

带 AS-I的漫射式传感器(3RG730)，带 AS-I的阀岛(662575)，带 AS-I的阀连

接器(666046)和带 AS-I的 S7控制器(671085)的操作指南在光盘

English\1_Distributing\Operating instructions。 

 PLC 程序 

在光盘 Sources\PLC programs\Release C\S7的 VE_AS-I_R2.zip文件中。 
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注意 

以下所有文档作为 PDF文件保存在 CD-ROM(665871)的 English\1_Distributing。 

 

供料单元 

料仓模块 

传送模块 

 

供料单元 

 

供料单元，电气 

供料单元，电气气动 

带 AS-I的供料单元，电气 

带 AS-I的供料单元，电气气动 

 

S7-314符号列表 

S7-314总揽 

S7-314流程图 

S7-314功能块图 

 

供料单元 

料仓模块 

传送模块 

 
 
 
 
 
 
 
 
 

CD-ROM 内容 

安装指南 

设备 

回路图 

程序列表 

元件清单 
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带 AS-I的 S7 控制器                            671085 

带 AS-I 的阀连接器                             666046 

带 AS-I的漫射式传感器                                                                              3RG730 

光栅                                                                                                 369669 

光纤导线                                                                                                          369684 

气缸                                                                                                                   391172 

接近式传感器 SME-8                                                                                    646518 

摆动气缸                                                                                                          235679 

光电式传感器，接收器                                                                               369662 

真空检测开关                                                                                                 382214 

带 AS-I的阀岛                                                                                                 662575 

 

3/2单电控电磁阀，常闭                                                                             161417 

5/2单电控电磁阀                                                                                          161414 

带 AS-I的阀接头                                                                                            196083 

接头                                                                                                                   153157 

接头                                                                                                                   153333 

带 AS-I的漫射式传感器                                                                                532929 

分配器                                                                                                               153209 

导线                                                                                                                    018685 

光纤导线                                                                                                           165360 

光栅                                                                                                  165327 

接头                                                                                                                    186117 

接头                                                                                                                    186285 

I/O端子                                                                                                              034035 

行程开关 S-3-E                                                                                                 007347 

单向阀 H-QS-4                                                                                                  153462 

单向节流阀                                                                                                       175056 

气管 4x0.75                                                                                                       159662 

气管 6x1                                                                                                             159664 

操作指南 

数据表 



 

45  

 

气缸 DSNU-8-80                                                                                               019181 

接近式传感器 SME-8                                                                                      150857 

摆动缸 DSR-16-180                                                                                         011910 

消音器 U-M5                                                                                                     004645 

导线插座 SIM-M8-3GD                                                                                   159420  

导线插座 SIM-M8-4GD                                                                                   158960 

过滤调压组件                                                                                                   152894 

真空吸盘 VAS-8                                                                                                036135 

光电式传感器，接收器                                                                                  165323 

真空过滤器 VAF-8                                                                                             015889 

真空发生器                                                                                                        185865 

真空检测开关 VPEV                                                                                         152629 
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关于 MPS工作站的更新信息和其它资料文档请访问： 

 
http://www.festo.com/didactic Service > MPS  
 
 
 
 
 
 
 
 
 
 
 
 
 

更新 


